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EndNote.com 
 Creates bibliographies 
 Manages bibliographies 
 Can be used to share bibliographies 
 Free online subscription 
 Enhanced version for UCSB affiliates 
 Can be used with MSWord to generate 

notes as you write, “cite while you write” 
 
 

 
 
EndNote Basic 
Collecting References: New Reference 

 This is how you enter the data yourself 
 Open MyEndNote Web (http://www.myendnoteweb.com) 
 Under the Collect tab, select New Reference 
 Select reference type (Book, Journal Article, Electronic Source, etc.) 

o Field options change to match the information that selected type requires 
o Type information in the fields 

 Author’s name is last name, first name 
 Separate multiple authors with a semicolon 
 Enter additional elements that you might want: keywords of interest to you, class or 

group name, where you have a copy of it filed, etc. 
o Select a folder – if you don’t want to save to an existing folder, select “New Folder” . You 

will be prompted to give the folder a name after you save the reference. 
o Click on Save 
o New reference becomes part of selected folder 

 

Collecting References: Online Search 
It is strongly recommended that you use the Import method of collecting references instead of Online 
Search.  See next section. 

 Under the Collect tab, select Online Search. 
 Select the database to search 

o Only works with select library catalogs and databases, such as, Library of Congress, 
PubMed, WorldCat and Web of Science (in WoS only does general searches, but you can 
limit to just a portion of WoS) 

o From Select Favorites, select the database you wish to use, click Copy to Favorites. The 
database will then be listed in the drop-down menu where you select it for the search. 

o Search the database. Check the boxes to select the ones you want 
o Add your selected references from each screen to a group using te Add to Group menu. 
o Note that sometimes searches time out and won’t reconnect. 
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Export records from 
database as a RIS file or 

tagged text file 

Export records from 
database to email 

Collecting References: Import 
To take records from a database to use in an EndNote folder, you have to EXPORT the records from the 
database and then IMPORT them into EndNote. EndNote has Import Filters for most of the databases. 

 

 
  

 
Importing from a database: General instructions 
Each database will be a little different when it comes to importing. Try a few things until you get it right. 
o Search the database as you normally would 
o Select the records you want; you may have to add them to a "save" list 
o Go to Save, Output, or Export 
o Export the files or save as text (.txt) or RIS (.ris) files (If the RIS formate is available, it’s generally 
preferable.) 
o Import the files into EndNote 

o You will have to export it into an existing group or into [Unfiled] 
o Diacritics are sometimes lost 

 
Direct import from Web of Science (includes Web of Science citation databases, BIOSIS Previews, 
Inspec, Derwent Innovations Index and Journal Citation Reports, among others): 
o You can import directly without first saving references in a file 
o In one window or tab, log into EndNote Web 
o In another window or tab, search the Web of Science database. 
o Select the records you want 
o Click on “Save to EndNote.com” above the record list 
o Records are imported to the [Unfiled] group and viewable there or under All My References 

 
Direct import from EBSCO databases (includes Academic Search Complete; Alternative Press 
Index; America: History and Life; American Bibliography of Slavic and East European Studies 
(ABSEES), Anthropology Plus, ATLA Religion, Business Source Complete, Education Full Text, 
Environment Index, Family & Society Studies Worldwide, Historical Abs, Left Index, LGBT Life, 
Readers; Guide Retrospective, RILM Abs, Women's Studies International, etc.) 
o You can import directly without first saving references in a file 
o Search database and click the Folder icon for each record you want 
o Click the Folder tink at the top of the screen. 
o Mark the records you want 
o Click "Export," then "Direct Export to EndNote Web" 
o The records will export to EndNote Web, which will open in a new tab or window 
o The records will appear in All My References; move them to a new or existing group as needed 
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To import a saved RIS file: 
o Open EndNote Web 
o Under the Collect tab, select Import References 
o Browse to the file of references you’ve saved from a database and open it 
o Select te RefMan RIS filter from the Import Option menu; if the one you want does not apear 

in the pulldown menu, find it in Select Favorites. o Select a group for your references, or New 
Group (you will be prompted to enter a group name) 

o Click the Import button 
o Records will be added to the group you selected; click the group name to view them; they will also be in 

All My 
References 

 
Examples of importing from a database as a saved file 

 
1) UCSB Library Catalog 
o Search the UCSB Library Catalog. 
o Select items and click “Add to Temporary List‟” 
o When finished, under View Results, select “My Temporary List” and select records you want to 

export (Alternatively, you may log in, save records to your permanent personal list, and work 
from “Saved Items”.) 

o Click "Print-friendly version" 
o From the format pulldown menu, select “MARC tags“ 
o Click "Print," then, on the next page,  "Print Records" 
o Use your Web browser to save the “print-friendly” page (usually under the File menu, “Save Page As…” 
o Rename file if you want 
o Follow the directions “to import a saved text file” at the top of 
page 3 o Use Harvard U as the Import Option (find it in Select 
Favorites) 
o Check to make sure EndNote Web imported the citation information correctly and manually 

edit as needed 
2) Melvyl Catalog 
o Sign in to your personal WorldCat account. (Registering to create a username and password is free.) 
o Search Melvyl Catalog 
o Note that this search may retrieve a mixture of book and journal articles. It is best to use the refine by 

Format options at the left of the screen to separate out the book records and save them as a separate 
file. 

o Check the records you want 

*To import a saved text file: 
 Open EndNote Web 
 Under the Collect tab select Import  References 
 Browse to find file name and click on  it 
 Select file type – you must select the database name AND the provider whom UCSB uses 

for access (e.g.: SciFinder (CAS); WorldCat via  OCLC) 
 Select a group in which to save the references. 
 Click on  the “Import” button 
 Records will be added to the group you selected. Click the group name to view them. They 

will also appear in the “All My References” group. 
 Import filters are not available for all databases (e.g., Hispanic American Periodicals 

Index).  For  these one must cut &  paste or  type in data 
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o Click "Save" and save the records to a new or existing list . (You must be signed in to “Save” records.) 
o On the “My WorldCat” tab, select “My Lists”, then select the desired list. 
o View the selected items in your list and check the ones you want 
o Click the Citations View tab 
o Export selected references: choose "as RIS" from the menu (you don't need to select a citation style; 

EndNote Web will format the citations for you) 
o Click "Export" and then ooSave  File 
o The default filename will look something like this: WorldCat_2246540.ris 
o Follow the directions “to import a saved text file” at the top of page 3 
o Use RefMan RIS as the Import Option (find it in Select Favorites) 
o Check to make sure EndNote Web imported the citation information correctly and manually edit as 

needed 
 
3) ProQuest databases (includes Aquatic Sci & Fisheries Abs (ASFA)g, ARTbibliographies Modern, 
Biological Sciences, Communication Abstracts, EconLit, Environmental Sciences & Pollution 
Management, ERIC, GeoRef, Index Islamicus, Internat’l Index to Music Periodicals, Internat’l Index to the 
Performing Arts, Los Angeles Times, MLA, New York Times, PAIS, ), Periodicals Archive Online, 
Periodicals Index Online, Philosopher's Index, ProQuest Dissertations and Theses, PsycINFO, 
Sociological Abstracts, Wall Street Journal, Worldwide Political Science Abstracts, etc.) 
o Search database and mark desired records 
o Click “Export/Save” 
o Choose document format: ooEndNote, Citavi, or Reference Manager. 
o Click the Continue button and save the file to your desired local drive. 
o Follow the directions “to import a saved text file” above. 
o Use RefMan RIS as the Import Option (find it in Select Favorites) 
o ProQuest may not export citation information into EndNote correctly, so after you import, check your 

references. To edit a reference, click on its title. Look at the Reference Type field to make sure it is 
correct (Journal Article, Book, etc.); if not, click in that field and select the correct type from the menu; 
then make sure the correct citation information (such as journal title, volume, issue, and date) is located 
in the correct fields and edit as necessary (this information may be located in the Notes field). 

 
4) Google Scholar 
o Click on Settings. 
o Change Bibliography Manager preference to “Show links to import citations into EndNote” 
o Save Preferences 
o Search Google Scholar 
o Each citation will now have the option “Import into EndNote” 
o Click "Import into EndNote" and then ooSave File (will be .enw file) 
o Follow the directions “to import a saved text file” at the top of page 3 
o For the Import Option select EndNote import 
o Check citation to make sure bibliographic data is complete; manually add or edit as needed 
o Check to make sure EndNote Web imported the citation information correctly and edit as needed 
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5) JSTOR 
o Search JSTOR and select records 
o Click "Export Citation" 
o Click "RIS file" and then on Save File 
o Follow the directions “to import a saved text file” at the top of page 3 
o For the Import Option select JSTOR 
o Check to make sure EndNote Web imported the citation information correctly and manually edit as 

needed 
 
6) Chadwyck (includes ABELL, American Film Institute (AFI) Catalog, Black Studies Center, 
Literature Online (LION) ) 
o Search database and select records 
o Click “Selected Records” or “Marked List” (varies by database) 
o Mark desired records if necessary and click “Download Selected Citations” or "Download Citations" 
o Click “Download in a format compatible with … EndNote …” and then o Save File 
o File will be .txt format 
o Follow the directions “to import a saved text file” at the top of page 3 
o For the Import Option select RefMan RIS 
o Check to make sure EndNote Web imported the citation information correctly and manually edit as 

needed 
 
7) Engineering Village (Compendex) 
o Search database and select records 
o Click the Download button 
o Select “RIS, EndNote, ProCite, Reference Manager” and then o Save File 
o File will be .ris format 
o Follow the directions “to import a saved text file” at the top of page 3 
o For the Import Option select RefMan RIS 
o Check to make sure EndNote Web imported the citation information correctly and manually edit as 

needed 
 
8) PubMed 
o Search database and select records 
o From the Send To menu, select o Citation manager 
o Click the "Create File" button and then o Save File 
o File will be .nbib format 
o Follow the directions “to import a saved text file” at the top of page 3 
o For the Import Option select PubMed (NLM) 
o Check to make sure EndNote Web imported the citation information correctly and manually edit as 

needed 
 
9) SciFinder 
o Search database and select records 
o Click the “Export” link on the right hand side of the SciFinder menu bar. 
o Under “Citation Manager”, select “Citation export format (.ris)” and enter the file name which you wish to 
use. Then click the Export button. 
o If the option to “Open with ResearchSoft Direct Export Helper” appears, use that. You will be prompted 
to log into EndNote, and the references will be directly exported. 
o Otherwise, save the .ris file and f the directions “to import a saved text file” at the top of page 3   Use the 
RefMan RIS import option.  As always, check to make sure the information has been imported correctly. 
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Languages and EndNote Web 
o Diacritics 

o For Latin alphabets, there are simple ASCII codes you can use to insert diacritics when EndNote Web 
does not import these correctly. 
o Please see the “ASCII Codes for Diacritics in EndNote Web” handoubt available on the UCSB Library 
EndNote subject guide to determine the correct code 

o Unicode 
o According to the help page, “EndNote Web is designed to work with Unicode for correct display of 
characters regardless of language, alphabet, or computer system.” 
o EndNote Desktop versions 9,10 and beyond are Unicode compliant 
o Arabic and Japanese fonts work can be imported from some databases into EndNote Web but do not 
always transfer smoothly into Word. 

 

ORGANIZING REFERENCES 
Managing Groups 
o All My References displays all references regardless of what group they are in 
o Under the Organize tab, select Manage My Groups to rename, delete, or share a group, and to create 

new groups 
o When you delete a group, its references are moved to [Unfiled] and may be viewed there or in All My 

References 
o A reference may be added to more than one group 
o When a reference in more than one group is deleted from that group, it is deleted from all groups and 

from All My References; it can be recovered from Trash if you haven't emptied Trash since deleting the 
reference 

 
Sharing Groups 
o Allow others to have read-only or read-and-write access to specific groups 
o To share, go to Manage My Groups under the Organize tab 
o Select "Manage Sharing" and then "Start sharing this group" 
o In the next box enter the email addresses of the people with whom you wish to share the folder 
o Shared groups will appear in Others' Groups under the Organize tab for those with whom you are 

sharing the group 
 
 
BIBILIOGRAPHIES AND CITATIONS: EndNote Web and MS Word 
Generating Bibliographies from an EndNote Library 
o If you want to create a bibliography from multiple groups, select the records you want from a group and 
then Copy to Quick List; repeat for each group 
o Go to Bibliography under the Format tab 

o References: select Quick List (or whatever group you want) 
o Bibliographic style: select the one you want or choose from Select 
Favorites o File format: select RTF (rich text format) 
o Click Save, then o Save File (as .rtf) or o Open with Word 

o In Word, check the citations to be sure they are properly formatted 
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Before using Cite While You Write you must download the EndNote Web Plug-In 
o Log into your EndNote Web account 
o On the bottom of the page click Download Installers 
o Under Cite While You Write select Download Windows or Download 
Macintosh o See Help > Plug-ins in EndNote Web for more information 
o The plug-in is a toolbar in Word 2003 and a tab in Word 2007 
o Note that on the Mac, you may need to set preferences to use EndNote Web, rather than 
desktop EndNote. 
o NOTE: The guidelines below are based on Word 2007 for Windows. 

 
Cite While You Write: List of Works Cited (MS Word) 
o EndNote Web inserts citations and builds your bibliography as you write your paper 
o EndNote web will format the citations and bibliography to match the output style you select 
o In the EndNote Web tab in Word, in the Bibliography window, choose the citation style you want. If 

you do not see the style you want, go Format Paper under the Format tab in EndNote Web, click 
Select Favorites and add it to My Favorites. You will have to re-start Word for the added style to 
display in the Style menu. 

o Place the cursor where you want to insert a citation 
o In the Citations window, click on Find Citations and in the search box, enter author's name, title 

keyword(s), or year 
o Select the desired reference and click Insert 
o You will now see the citation in your MS Word document; example: (Barnhart, 2005) 
o At the end of the document, the reference will appear correctly formatted in your bibliography 
o If you do not want the author's name (or the year, or both) in the citation (for example, you do not 

want the author's name because it is in the sentence), select the appropriate choice from the Insert 
menu (Insert & Exclude Author, etc.). 

o To remove a citation, go to Edit Citations, select the citation you want to remove, and click Remove 
and OK. The citation will be deleted, but to remove the reference from the bibliography, click Update 
Citations and Bibliography. 

 
Cite While You Write: Footnotes and Endnotes (MS Word) 
o Insert EndNote web references in your footnotes and endnotes 
o EndNote Web will format these to match your citation style while using them to build your bibliography at 

the end of your document 
o In the EndNote Web tab in Word, in the Bibliography window, choose the citation style you want. See 

the third bullet above of the style you want is not in the style menu. 
o In your document, place the cursor where you want to insert a footnote or 
endnote. o References tab o Insert Footnote (or Insert Endnote) 
o With the cursor in the footnote (or endnote) space, go to the EndNote Web tab in Word and click on 

Find Citations (in the Citations window) 
o In the search box type enter author's name, title keyword(s), or year 
o Select the desired reference and click Insert 
o The reference now appears in your footnote (or endnote) and in your bibliography 

 
Footnotes and Endnotes: Adding Page Numbers; Deleting 
o In the EndNote Web tab click on Edition Citation(s) 
o Select the citation to which you want to add page numbers 
o In the Pages box, add the page numbers. Just type in the numbers without any abbreviation (p., pp., 
etc.); EndNote Web will format with the abbreviation for the citation style you have selected. 
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o To remove a footnote or endnote, simply delete the footnote or endnote reference number in  the 
document 

o The citation will be removed but the bibliography reference will remain; to delete it, click Update 
Citations and Bibliography under the EndNote Web tab. 

 
Editing and Formatting your paper 
o Citations in your document look like this when they are unformatted: {Ellis, 2004} or, with page number: 

{Ellis, 2004@24-25} 
o To unformat all your citations, click on Convert Citations and Bibliography and then Convert to 

Unformatted Citations (your bibliography appears only when the citations are formatted) 
o To re-format, click on Update Citations and Bibliography 
o You can only edit citations (by clicking on Edit Citations) when they are formatted 
o To format your bibliography, select o in the Bibliography window under the EndNote Web tab; under 

Layout in the dialog window, you can change the bibliography title, font, line spacing, etc. 
 
Backing Up & Restoring Your Files 
Backing Up Your EndNote Web Library 
This feature allows you to save a copy of your references on your hard drive so you can restore them if 
you need to. Be sure to save your reference library on a regular basis so you will have the most recent 
version if you need to restore it. 
Exporting records from EndNote Web to your computer 
o Format tab → Export References 
o References: select All References in My Library 
o Export style: select RefMan (RIS) Export 
o Click Save 

 

Other Downloadable Add-ons 
EndNote also offers add-ons that work with your browser to enable you to cabture references from the 
Web. From the “Download Installers” page, select either “Capture Refrerence” or the Firefox 
Extension. Note that neither of these is essential for using EndNote.com, but may provide added 
convenience. 

 
Match 
Using information from Web of Science and Journal Citation Reports, EndNote can take title, abstract and 

cited reference information for your manuscript and recommend journals in which you might wish to 
publish. 

 
Connect (BETA) 
EndNote.com has created an optional online user community. You may create a Connect account linked 
to your EndNote.com account and share questions and answers, tips and strategies with other EndNote 
users around the globe. 


